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Introducing the Version Manager Web Client
The PVCS Version Manager web client is the web-based client component of Version 
Manager that allows you to access Version Manager projects via the Internet or intranet. 
The Version Manager web client works with the Version Manager Server, the web-based 
server component of Version Manager.

With the Version Manager web client, you can use your web browser to view detailed 
information about projects and archives, and to perform such tasks as checking in and 
checking out files, managing locks, version labels and promotion groups, and running 
reports.

Because the Version Manager web client allows you to access Version Manager projects 
from any connected point on the Internet or intranet, it's ideally suited for remote users, 
mobile users and users in web-intensive environments, such as members of Internet 
programming and content development teams.

In addition, the lightweight web browser interface offers the benefits of a very low cost of 
maintenance for users and administrators in all environments.

Version Manager Web Client Features
The Version Manager web client provides the essential end-user version control features 
of Version Manager. It is designed for users who do not need access to administrative 
features.

The Version Manager web client online help provides detailed procedures for using these 
features.

The Version Manager web client provides the following features:

 Add Workfiles. Add one or more workfiles to a project database or project. You can 
also add an entire directory with subdirectories, which becomes a project with 
subprojects in the project database.

 Create Projects. Manually create new projects with a different directory structure 
than the existing workfile structure.

 Check in and Check out. Check files in to and out of archives.

 Get. Get copies of revisions without checking them out.

 Lock and Unlock. Lock and unlock revisions of files.

 Version Labels. Assign, change, and delete version labels.

 Promotion Groups. Promote revisions, and to assign, change, and remove 
promotion groups.

 History Reports. Run reports that show detailed information on archives.

 Difference Reports. Compare two revisions or two workfiles, or compare a workfile 
and a revision. 

 Merge Files. Merge two revisions or two workfiles, or a workfile and a revision. 

 Options. Set default dialog box and display options.
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 Copy and Move. Copy or move versioned files between projects in a project 
database.

 Workspaces. Set, create, rename, and delete public or private workspaces.

 Rename. Change the names of projects and Version Manager 5.3/6.0 folders in the 
interface.

 Delete. Remove projects, Version Manager 5.3/6.0 folders, and versioned files from 
the interface.

 Change Password. Change the password you use to log in to a project database. 
This also changes your password in Version Manager if an Access Control Database is 
in place.

Version Manager Web Client Components
The combined services of the Version Manager Server component, a supported web 
server, and the Version Manager web client component provide access to your archives via 
the Internet or an intranet.

Before you can use the Version Manager web client, your products administrator must 
install the Version Manager Server component on a system that is running a web server. 
Once the Version Manager Server is configured for use with Version Manager projects, 
you can log into the Version Manager web client interface and view detailed information 
about projects and perform actions from within your web browser.

Using the Version Manager Web Client with
Version Manager

You must use Version Manager to perform all administrative tasks on project databases. 
Administrative tasks can include creating and configuring project databases or roots, 
defining security, and setting up promotion models.

Most end-user tasks in the Version Manager web client, such as checking out files or 
adding workfiles, follow the same procedures as those in the Version Manager desktop 
client. These procedures are documented in the Version Manager Web Client online help. 
However, some differences do exist for tasks involving version labels and promotion 
groups.

Version Labels and Promotion Groups

When working with version labels and promotion groups in Version Manager, you choose 
the specific operation you want to perform from the menu. For example, you choose 
Actions | Version Label | Assign to assign a version label or Actions | Promotion Group | 
Remove to remove a promotion group. 

In the Version Manager web client, you perform all operations with version labels and 
promotion groups by selecting the Label button or Promote button on the Actions menu. 
At the top of the Version Label or Promotion Group dialog box, you select which operation 
you want to perform. The contents of the dialog box change with your selection.
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For example, if you select Actions | Label, the dialog box appears as below. By default, 
the Assign option is selected and the contents of the dialog box correspond to that 
operation.

If you select the Rename option, the contents of the dialog box change:

NOTE  It is best practice to use version labels that do NOT look like revision numbers.
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Using TrackerLink (Tracker) with the Version Manager 
Web Client

You can use TrackerLink in the Version Manager web client or desktop client to associate 
workfiles with issues in Tracker. Use TrackerLink as a tool to bridge Tracker and Version 
Manager. When checking in, checking out, locking, or adding workfiles, you can associate 
those workfiles with issues through the TrackerLink Workfile Association dialog box.

Configuring
TrackerLink

Before you can use TrackerLink, your administrator must:

 Configure TrackerLink options. See the Administrator's Guide.

 Associate the servlet for your Version Manager project database with the URL of a 
Tracker database. See the Administrator’s Guide.

Using TrackerLink
Use TrackerLink to associate issues with workfiles when you:

 Check out a file

 Check in a file

 Lock a file

 Add new workfiles

If your settings do not automatically log you in to Tracker, you will be prompted for your 
login information when you associate workfiles.

To associate an issue with a workfile on check in, check out, adding workfiles, or 
on locking a file:

1 Select the files you want to associate with issues.

2 Make the check in, check out, add workfiles, or lock request.



12 PVCS Version Manager 

Chapter 1  Version Manager Web Client Basics

3 Click the Associate Issues button on the Check Out, Check In, Lock, or Add 
Workfiles dialog boxes. The TrackerLink Workfile Association dialog box appears.

4 Select a query from the Queries pane to run a query to find and select the issues to 
associate with your workfiles or find them in the In Tray. 

5 From the Workfiles pane, select the files to associate with an issue.

6 Double-click the first issue number to associate with your workfile. This associates 
that issue with the workfile, and the number that appears to the left of the workfile 
name increases by one. You can also choose the Associate button to associate the 
issue and your workfile.

7 Double-click the workfile name to see the currently associated issues. If its title and 
description appear, the issue is currently selected. 

8 If you change your mind about a particular association, you can:

• Double-click the issue number in the Workfiles pane to unassociate it.

• Select the issue and click the Unassociate button.

If a file has no associations, the current workfile will have a plus sign next to it. When you 
select it, it will appear with "(no associations)" below it.

NOTE  You can associate several files with one issue at the same time, but you 
can not select a query and associate all of its matching issues with a workfile or 
workfiles at the same time. Issues must be selected individually.
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Launching the Tracker Web Client

You can access the Tracker web client by clicking the Tracker icon  on the Actions 
tab.

Using SourceBridge (TeamTrack) with the Version 
Manager Web Client

You can use SourceBridge in the Version Manager web client or desktop client to associate 
workfiles with issues in TeamTrack. When checking in, checking out, locking, or adding 
workfiles, you can associate those workfiles with issues in TeamTrack.

Configuring
SourceBridge

Before you can use SourceBridge, your administrator must:

 Configure SourceBridge options. See the Administrator's Guide.

 Associate the servlet for your Version Manager project database with the URL of a 
TeamTrack database. See the Administrator’s Guide.

Using SourceBridge
Use SourceBridge to associate issues with workfiles when you:

 Check out a file

 Check in a file

 Lock a file

 Add new workfiles

To associate an issue with a workfile on check in, check out, adding workfiles, or 
on locking a file:

1 Select the files you want to associate with issues. 

2 Make the check in, check out, add workfiles, or lock request.
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3 Click the Associate Issues button on the Check Out, Check In, Lock, or Add 
Workfiles dialog boxes. SourceBridge will opens.

Search 4 Complete any of the following fields to specify the issues you want to work with:

 Project (includes Sub-Projects): Select a TeamTrack project.

 Keywords: Enter keywords to search for. You may use the percent symbol (%) as 
a wildcard.

 Show Only Items I Own: Select this check box to limit the search to items that 
you own.

 Item ID: Enter the ID of the item(s) to search for. You may use the percent 
symbol (%) as a wildcard.

 Append Search Results to List: Select this option to append new search results 
to any existing items in the Results pane. If this option is not selected, any existing 
results will be replaced when you run a new search.

 Filter on Active/Inactive:

• Active: Select this option to search for only those items that are active.

• Inactive: Select this option to search for only those items that are inactive

NOTE  To log in as a different user, click the Logon button.
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• Both: Select this option to search for items regardless of whether they are 
active or inactive.

5 Click the Search button. The search results appear in the Results pane.

Results 6 To view the details of a TeamTrack issue, click its ID. The issue will then open in the 
TeamTrack web client.

7 Select the check box next to the issue(s) that you want to associate with items under 
source control.

Associations 8 From the Associations pane, select the files to associate with the selected issues.

9 Click the Associate button to associate the selected issues and workfiles. The 
associations are then displayed in the Associations pane.

10 To remove an association, select the issue in the Associations pane and click the 
Unassociate button.

11 Click the Done - Continue with . . . button.

Launching the TeamTrack Web Client

You can access the TeamTrack web client by clicking the:

 TeamTrack icon  on the Actions tab of the Version Manager web client.

 Issue ID in the Results pane of the SourceBridge associate dialog.

Using the Version Manager Web Client with Previous 
Releases

You should upgrade Version Manager 5.3/6.0 project roots to the current format using 
Version Manager. However, you can still access 5.3/6.0 project roots in the Version 
Manager web client without upgrading them. While most functionality is supported in this 
scenario, some restrictions apply to ensure compatibility with the Version Manager 5.3/
6.0 GUI. 

You cannot:

 Create, delete, or rename projects within the Version Manager 5.3/6.0 project root. 
However, you can perform these actions on 5.3/6.0 folders.

 Add multiple directories. You can add a single directory by selecting all of the files 
within it.

 Automatically see newly added archives in the content pane. You must use the Update 
Project Folder option to update the display if archives have been added in other 
interfaces, such as the command-line interface.



16 PVCS Version Manager 

Chapter 1  Version Manager Web Client Basics

System Requirements
The Version Manager web client is supported on Windows and UNIX operating systems. 
For specific supported platform, web browser, and version information, refer to the 
readme file (readmevm.htm).
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Connecting to the Version Manager Web Client
You connect to Version Manager web client to establish a link between your web browser 
and Version Manager project databases or roots. You must connect to the Version 
Manager web client before you can log into a project. 

To connect to the web client:

1 Start your web browser.

2 Open the URL of the Version Manager Web Client Project Databases page. The URL of 
this page is http://hostname:port/vminet.html (for non-secure web services) or 
https://hostname:port/vminet.html (for secure web services), where hostname 
is the name of the system hosting the Version Manager Server and port is the server 
port.

The Project Databases page appears.

3 Click the name of the project database or root to which you want to connect in the 
Link list.

After you have connected to the Version Manager Server, the Login page appears. 
Continue to the next section. 

Logging In to a Project Database
Log in to a project database when you want to access Version Manager projects, 5.3/6.0 
folders, and versioned files. To log in to a project database, you must have a valid user ID 
and password or Common Access Card and PIN. Typically, your administrator assigns user 
IDs and passwords.

The web client can present two different login screens, depending on how your project 
database is configure:

 Regular login

 Single Sign On / Common Access Card login
See "Single Sign On / Common Access Card Login" on page 20.

TIP  If you know the URL of the project database, or if you have the location bookmarked 
in your web browser, you can open the URL directly without connecting to the Project 
Databases page. Optionally, bookmarks can include the specific project you want to 
open. For example: http://ServerName/SampleDB/chess/client.

NOTE  You can also access the online documentation and the client applet 
management page from the Project Databases page. 

NOTE  From an individual web client system, do not open more than one connection to a 
given Version Manager web server at a time. If you have multiple web servers, you can 
open a single connection to each server in its own browser tab or browser instance, but 
do NOT invoke more than one dialog at a time (for example, do not run Get dialogs from 
two tabs at the same time).
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Regular Login
This is the traditional User ID and Password login.

To log in to a project database:

1 Open the Login page by connecting to Version Manager web client as described in 
"Connecting to the Version Manager Web Client" on page 18. The Login page appears.

2 Enter your user ID in the User ID field. 

3 Enter your password in the Password field.

NOTE  If the project database is configured to use Host ID as the login source and:

 A password is required, the User ID field will be prepopulated and uneditable.

 A password is not required, the user will be logged in automatically and the login 
dialog box will not be displayed.

NOTE  

 If you have a password for the project database in the Version Manager desktop 
client, your web client password will match your desktop client password.

 For security reasons, the Input Method Editor is disabled in the Password field. 
You will not be able to enter double-byte characters in this field.
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4 (optionally) To free licenses from any stale login sessions that you may have open, 
select Automatically close all other sessions for your user ID on this server. 

5 Click OK.

You may also need to log in to a project if your administrator has configured an Access 
Control Database for it. In this case, the Login page appears when you select the project.

To log into a project:

1 Enter your user ID in the User ID field.

2 Enter your password in the Password field.

3 Select the Remember this user name/password option to store this information 
so that you don't have to log in to the project for future Version Manager web client 
sessions.

4 Click OK.

Single Sign On / Common Access Card Login
If your project databases are configured for this login type, you can login to one project 
database and not be prompted when accessing another. You may also access the SBM 
client without logging in again. Also, in addition to User ID and Password, this login page 
supports Common Access Card (SmartCard) and PIN login.

To log in to a project database:

1 Open the Login page by connecting to Version Manager web client as described in 
"Connecting to the Version Manager Web Client" on page 18. The Login page appears. 

2 Do one of the following:

 For User ID and Password based SSO login, complete the User Name and 
Password fields and click the Log In button.

 For Common Access Card and PIN based login, click the SmartCard Login button. 
A dialog appears from your third party SmartCard utility:

NOTE  If the project database is configured to use Host ID as the login source and:

 A password is required, the User ID field will be prepopulated and uneditable.

 A password is not required, the user will be logged in automatically and the login 
dialog box will not be displayed.

NOTE  

 If you have a password for the project in the Version Manager desktop client, 
your web client password will match your desktop client password.

 For security reasons, the Input Method Editor is disabled in the Password field. 
You will not be able to enter double-byte characters in this field.

NOTE  You will see this page and these login options only if the project database you are 
attempting to access has been configured to support these login sources. See the Version 
Manager Administrator’s guide.
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a Enter your PIN in the third-party SmartCard utility and click OK. A dialog 
appears with a list of user certificates available on your SmartCard.

b Select a user certificate and click OK.

Changing Your Password
You can change the password assigned to you by your administrator at any time. The 
password you change is the one that you entered in the Login page. Once you've changed 
your password, the new password takes effect the next time you log into the Version 
Manager web client.
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If security is enabled in Version Manager for this project database, changing your 
password in the Version Manager web client changes it in the desktop client as well (and 
vice-versa).

To change your password:

1 On the File menu tab, click the Change Password button. The Change Password 
dialog box appears.

2 Enter your current password in the Old password field.

3 Enter your new password in the New Password field, up to 29 characters.

4 Re-enter the new password in the Verify new password field.

5 Click OK.

Switching Users
You can continue to work with an open project database or project using a different user 
name and password. The Switch User option provides a quick way to switch to a user ID 
with different privileges without having to close and reopen the project database. 

This option is only available if the Administrator has configured the project database, 
project, or subproject using the Login dialog security option.

To switch users for a project database or project:

1 On the File menu tab, click the Switch User button. 
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The Switch User dialog box appears.

2 Enter the new user ID in the User ID field.

3 Enter the password in the Password field, if required.

4 Click OK.

Logging Out of a Project Database
Log out of a project database when you are finished with your source control tasks or 
when you want to log in to a different project database. When you log out of a project 
database, your Version Manager web client session is immediately terminated, requiring 
you to re-enter your user ID and password the next time you want to access a Version 
Manager project database.

To log out of a project database:

 Click the Logout button, located on the right side of the tabbed menus. The Logout 
page appears.

 To log into a different project database, click the vminet.html link to view a list of 
project databases available on this server.

NOTE  Depending on your servlet configuration, if you do not explicitly log out of a 
project database, a time logout based on inactivity may occur.
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Managing the Web Client Applet
You can remove existing applet installations and specify the applet installation location. 

To manage web client applets: 

1 Open the Version Manager Web Client Configuration page. You can click the link from 
the Version Manager Project Databases page, or directly enter the URL:

http://YourServer:Port/vminet_install.html 

2 Do any of the following:

 Uninstall an Applet: Click the Remove link for the applet you wish to uninstall.

 Uninstall all Applets: Click the Uninstall All Applets link to uninstall all applets 
that are 8.4.5 or newer. 

 Apply Default Location: Click the To Default link to use the default Version 
Manager applet location for future installations.

 Specify Custom Location:

a Select the Custom option.

b Enter or browse to the desired location for future installations.

c Click the Apply Custom link. 

NOTE  To uninstall pre 8.4.5 applets, use your operating system's program management 
utility (e.g. "Add or Remove Programs" or "Programs and Features"), or use the Add-ons/
Plugins feature in FireFox or Mozilla.

NOTE  If you wish to remove the currently running applet, you must close all 
browser instances and not open a Version Manager project before opening the 
Version Manager Web Client Configuration page.
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Version Manager Web Client Panes
The Version Manager web client the following panes:

 Project

 Content

 Revision

 Menu

 Status

Working in the Project Pane
The Project pane displays the open project database and its projects, subprojects, and 
5.3/6.0 folders in a hierarchical tree. Click +/- to expand or collapse the tree. When you 
select a project, subproject, or 5.3/6.0 folder, its versioned files appear in the Content 
pane to the right.

The following icons can appear in the Project pane:

Working in the Content Pane
The Content pane displays the versioned files contained in the project database or project 
that you selected in the Project pane. To:

 Select versioned files for action, click the check boxes next them.

 Edit or view a versioned file in the default editor or browser, click the file icon.

 Open the Revision pane and view details on all of the revisions in a versioned file, click 
the file name.

Icon Description

The open project database displayed by its name and its location in 
parenthesis. A 5.3/6.0 project database displays by its location only.

A project, subproject, or folder. The icon for a 5.3/6.0 project or folder 
appears in blue.

A project with a configuration file attached to it. These configuration 
settings override the project database settings. The icon for a 5.3/6.0 
project appears in blue.

A project that you cannot open because you have not been defined in the 
Access Control Database. The icon for a 5.3/6.0 project appears in blue.

NOTE  For information on setting the default editor, see "Setting Your Default Editor" 
on page 56.
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 Sort the versioned files, click the heading of the column you wish to sort by. To 
inverse the sort order, click the column heading again.

The Content pane contains the following fields and icons:

Working in the Revision Pane
Once you click a versioned file link, the Revision pane appears. The Revision pane displays 
details on all revisions of the versioned file. To:

 Select a revision for action, click the check box next it.

 Edit or view a revision in the default editor or browser, click the revision number.

 Sort the revisions, click the heading of the column you wish to sort by. To inverse the 
sort order, click the column heading again.

Field or Icon Description

Contents of Displays the name of the project database or project in which the 
versioned files reside.

Workfile Location Displays the project's workfile location

Page Only displays when more items exist than can be contained on 
the page. Click Previous, Next, or [number] to go to the previous, 
next, or specific page. Click Index to go to the Page Index on the 
bottom, which lists the first and last files on each page.
This field is duplicated at the bottom of the page, except the 
Index link is replaced by Top, which takes you to the top of the 
page.

Select/Deselect Options to select and clear all items. If more items exist than can 
be contained on the page, you can choose to select all items on 
the current page.

Name The name of the versioned file. Click to open the Revision pane.

Date Checked In The date and time the versioned file was last checked in.

Locked By The user ID that currently holds a lock on the item.

Checked Out To 
Location

If versioned file is checked out, displays the path the file is 
checked out to.

A versioned file that does not contain any locked revisions. view 
or edit the file in the default editor.

A versioned file that contains a locked revision. view or edit the 
file in the default editor.

A versioned file that references an archive that cannot be found.

Page Index Only displays when more items exist than can be contained on 
the page. It displays the page number and first and last files on 
each page.

NOTE  For information on setting the default editor, see "Setting Your Default Editor" 
on page 56.
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The Revision pane contains the following fields and icons:

Field or Icon Description

Revisions of Displays the name of the versioned file containing the revisions.

Workfile Location Displays the workfile location of the versioned file. Click the 
workfile location link to bring up the Set Workfile Location dialog 
box.

Page Only displays when more items exist than can be contained on 
the page. Click Previous, Next, or [number] to go to the previous, 
next, or specific page.

Return to the 
contents of the 
project

Brings you back to the Content pane.

Revision The number of the revision. The default revision is selected. Click 
to edit or view the revision in the default editor.

Author The original author of the revision.

Date Modified The timestamp on the file when it was last checked in.

Locked By The user ID who currently holds a lock on the revision.

Description The description added to the revision when it was checked in.

Labels If a label is assigned to the revision, the label name displays.

Promotion Groups If a promotion group is assigned to the revision, the promotion 
group displays.

A revision.

A locked revision.

A revision assigned a promotion group.

A locked revision assigned a promotion group.

A revision assigned a version label.

A locked revision assigned a version label.

A revision assigned a promotion group and version label.

A locked revision assigned a promotion group and version label.



Version Manager Web Client Panes

Web Client User's Guide 29

Working in the Menu Pane
The Menu pane provides buttons to execute Version Manager web client commands. Click 
a tab to access the commands on the File, Edit, Actions, or Help menu. Click a button on 
the menu to execute a command.

The following menu buttons are available:

File menu 
button

Description

Creates a new project or 5.3/6.0 folder.

Sets or changes a workfile location for the selected project 
database, project, or versioned file.

Updates 5.3/6.0 project folders to display new archives added by 
other users.

Renames an existing project or 5.3/6.0 folder.

Deletes an existing project, 5.3/6.0 folder, or versioned file.

Displays the properties of a project database, project, 5.3/6.0 
folder, or versioned file.

Sets, creates, renames, or deletes workspaces.

Switches to a different user ID for the selected project database or 
project.

Changes your password for logging into the selected project 
database or project.

Edit menu 
button

Description

Copies one or more versioned files to another project or 5.3/6.0 
folder. 

NOTE  The archives remain in their original location.

Moves one or more versioned files to another project or 5.3/6.0 
folder. 

NOTE  The archives remain in their original location.
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Sets options for the Version Manager web client display and 
operations.

Actions menu 
button

Description

Adds workfiles to a project database, project, or 5.3/6.0 folder.

Gets a revision and makes a copy in the workfile location.

Checks out an editable revision to the workfile location.

Checks in a modified workfile to the archive.

Unlocks a revision without performing a check in.

Locks a revision without performing a check out.

Assigns, renames, or deletes a version label from a revision.

Assigns, promotes, changes, or removes a promotion group from 
a revision.

Creates a history report on a project database, project, versioned 
file, or 5.3/6.0 folder.

Launches the Merge Tool to compare (difference) revisions or 
workfiles.

Launches the Merge Tool to merge revisions or workfiles.

Launches Solutions Business Manager (SBM).
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Working in the Status Pane
The Status pane lets you view and modify your current filter, user ID, and workspace. It 
also displays the number of items that are currently selected. To:

 Change the display of versioned files in the Content pane, click the Filter list. 

 Switch users, click the user ID. 

 Set a different workspace, click the Workspace name.

The Status pane consists of the following fields and icons:

Help menu 
button

Description

Launches the Version Manager web client help system.

Launches the What's New page in the help system. The What's 
New page communicates to you what features are new in this 
version of Version Manager.

Brings up the support page.

Displays an About box with Version Manager web client copyright 
and version information.

Logs you out of the project database.

Icon Description

Filter View all files or filter your view by filename wildcards, locker, version 
labels, or promotion groups. Retains the last four filters used.

Toggle between recursive and non-recursive filter modes: 

  Recursive: The Content pane displays all projects, subprojects, 
and versioned files contained within the item selected in the Project 
pane. 

  Non-recursive: The Content pane displays only the versioned 
files contained at the root of the item selected in the Project pane. 

The current user ID displays here. Click the name to switch to another 
user ID for this project database.



32 PVCS Version Manager 

Chapter 3  Navigating the Interface

Selecting Items
Select items in the Version Manager web client to view information on them, or to perform 
actions such as check in, get, check out, lock, unlock, or assign a version label. After you 
have selected the items, click a menu button to perform an action.

Moving Items
You can move versioned files between projects or folders within a project database. When 
you move versioned files, the archives that they reference do not move. The versioned 
files continue to reference the archives in their original location.

Use the Version Manager desktop client to move other items, such as projects and folders.

To move a versioned file:

1 Select one or more versioned files.

The current workspace displays here. Click the workspace name to set a 
different workspace for this project database.
The workspace icon indicates if the workspace is public or private.

[#] of 
[total] 
[items] 
selected

Displays the number of currently selected projects, folders, versioned files, 
or revisions. For versioned files and revisions, it also displays the total 
number of versioned files in the project and the number of revisions of a 
versioned file (for example, 4 of 50 files selected).

Icon Description

Public

Private

To select... Do this...

The project database Click the project database in the Project pane.

A project or folder Click the project or folder in the Project pane.

Multiple projects Press and hold the SHIFT or CTRL key while clicking 
the projects in the Project pane. You can only select 
multiple projects if they belong to the same parent 
project.

One or more versioned files Click the check boxes next to the versioned files in 
the Content pane. To select all of the versioned files 
in a project, click the Select: All link. When 
versioned files exist on multiple pages, you can click 
the Select: All on this page to select the versioned 
files on the current page only.
If you navigate to another page after clicking 
Select: All, the selection is canceled.

A revision Click the radio button next to the revision in the 
Revision pane.
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2 On the Edit menu tab, click the Move button. The Move File dialog box appears.

3 Select the destination project or folder in the project navigation tree. To move the file 
directly beneath the project database or root, select the project database or root.

4 Click OK. The versioned file moves to the destination location.

Renaming Items
You can rename a project or 5.3/6.0 folder in the Project pane. The new project name 
appears in both the Version Manager desktop and web clients, but the actual archive 
directory name is not changed. 

NOTE  You cannot rename versioned files or 5.3/6.0 projects.

If the previous workfile location matched the old project name, a new workfile location is 
set to match the new project name. You check out, copy, and check in files from the new 
workfile location. Any files checked out before you renamed a project or folder remain in 
the original workfile location.

To rename a project or folder:

1 Select the project or folder you want to rename.

2 On the File menu tab, click the Rename button. 
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The Rename Project/Folder dialog box appears.

3 Enter the new name in the Name field.

4 Click OK.

Deleting Items
You can delete projects, 5.3/6.0 folders, and versioned files, depending on your security 
privileges. You cannot delete 5.3/6.0 projects. All deleted items are removed from both 
the Version Manager desktop and web clients. However, the archives of the deleted items 
are not removed from the archives directory. The project configuration file and access 
control database are also retained.

If you want to recover deleted projects, 5.3/6.0 folders, or versioned files, use Version 
Manager to import the archives into a project database or project. 

To delete a project, folder, or versioned file:

1 Select the item you want to delete. You can select one or more projects, folders, or 
versioned files.

2 On the File menu tab, click the Delete button. 
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The Confirm Delete dialog box appears.

3 Click OK to delete the item.

Reviewing Item Properties
You can review the properties of a project database, 5.3/6.0 project root, project, 5.3/6.0 
folder, and a versioned file. Properties vary according to the item you select.

To view the properties of an item:

1 Select a project database, project, folder, or versioned file.

If you select a... You can...

Project database or project View its contents, configuration file, and archive 
location. You can also view or change the workfile 
location, default version, default promotion group, 
branch version, and base version.

5.3/6.0 project root or project View its contents and configuration file. You can also 
view or change the default version, default promotion 
group, branch version, and base version.

5.3/6.0 folder View its contents. You can also view or change the 
workfile location.

Versioned file View archive information. You can also view or change 
the workfile location.
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2 On the File tab, click the Properties button. The Show Properties dialog box appears.

3 View or change the default settings as necessary. See Chapter 4, "Customizing Your 
Environment" on page 51.

4 Click OK.

Filtering Your View
By default, when you select a project database, project, or folder, the Version Manager 
web client displays all of its associated versioned files in the Content pane. The file filter 
allows you to customize the Content pane so that only the versioned files that match your 
filter criteria appear. You can filter your view to display only versioned files that:

 Are locked by specific users or by any user

 Match a wildcard filename pattern

 Match a specified promotion group

 Match a specified version label

 Differ or match in terms of revision number, modification time, or revision contents 
between:

• Two version labels

• Two promotion groups

NOTE  The appearance of the Show Properties dialog box varies depending on the 
type of item you selected.
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• A version label and a promotion group

Performing actions
on a filtered

project

If you perform an action (such as a check out) on a project by selecting it in the Project 
pane, Version Manager performs the action on all files in the project, including any files 
not displayed by the current filter (Note, files in subprojects within the selected project 
are ignored). To limit an action to only the versioned files displayed by the current filter, 
select the versioned files in the Content pane and then select the action.

Viewing Files Recursively
By default, the Content pane displays only the versioned files located at the root of the 
item (project database, project, or subproject) you have selected in the Project pane. 
Unless you select the recursive view, projects, subprojects, and the files contained within 
nested projects and subprojects are not displayed. 

To switch between recursive and non-recursive views:

1 In the Project pane, select the project database or project that you want to view.

2 Click the Recursive/Non-recursive button. The appearance of the button toggles to 
indicate which filter mode is in effect: 

  Recursive: The Content pane displays all projects, subprojects, and 
versioned files contained within the item selected in the Project pane. 

  Non-recursive: The Content pane displays only the versioned files contained 
at the root of the item selected in the Project pane. 

Filtering by Locker
Use this filter to find versioned files locked by specified users or by any user.

To set a Locked By filter:

1 From the Filter list on the Status pane, select Locked By. The Locked By Filter dialog 
box appears.

NOTE  A filtered view remains in effect until you select a different one. To avoid 
confusion, you may want to clear a filtered view by returning to the All Files view before 
going on to other work.
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2 Do one of the following:

 To display versioned files locked by specific users, select the Users option and 
enter one or more user IDs. Separate multiple user IDs with the delimiter 
character. The default delimiter is a semicolon (;). For information on setting the 
delimiter character, see "Specifying a Delimiter for Items Entered in Fields" on 
page 53.

 To display all locked versioned files regardless of who has them locked, select the 
Any user option.

3 Click OK.

Filtering by Wildcard Filename
Use this filter to find versioned files that match specified wildcard name or regular 
expression patterns.

To set a wildcard filter:

1 From the Filter list on the Status pane, select Wild Card. The Wild Card Filename 
Filter dialog box appears.
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2 Enter filter criteria in the Filename pattern field.

You can use the delimiter character to separate multiple filename patterns. The default 
delimiter is a semicolon (;). For information on setting the delimiter character, see 
"Specifying a Delimiter for Items Entered in Fields" on page 53.

Select Ignore case to view versioned files that match the filter pattern regardless of the 
case of the file name.

3 Click OK.

To set a regular expression filter:

1 From the Filter list on the Status pane, select Wild Card. The Wild Card Filename 
Filter dialog box appears. 

2 Select Regex patterns to use regular expression filter.

Use this wild card… To search for filenames that match…

* Zero or more characters.
For example, if you want to search for all versioned files with a 
DLL extension, enter *.DLL.

? One character.
For example, if you want to search for versioned files that had 
a pattern in the filename, such as TEST01.DLL, TEST02.DLL, 
… TESTXX.DLL, enter TEST??.DLL.

[ - ] A range of characters. 
For example, if you want to search for all versioned files that 
start with A, B, C, or D, enter [A-D]*.

^ A negative character set matching any character that is not 
enclosed. For example, [^A-D]* for all file names that do not 
start with A, B, C, or D.
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3 Enter regular expression filter criteria in the Filename pattern field. For information 
on supported regular expressions, see "Summary of regular-expression constructs" 
on page 49.

Filtering by Version Label
Use this filter to find versioned files that include specified version labels.

To set a version label filter:

1 From the Filter list on the Status pane, select Advanced Filter. The Advanced Filter 
dialog box appears.

2 Enter the name of the version labels that you want to filter by in the Version 
label(s) field or browse to select them. Separate multiple version labels with the 
delimiter character. The default delimiter is a semicolon (;). For information on setting 
the delimiter character, see "Specifying a Delimiter for Items Entered in Fields" on 
page 53.

NOTE  Version labels are case sensitive. Make sure you use the correct case.
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3 Select one of the following options to show versioned files that contain the specified 
version labels in:

 Any revision: Version label.

 The tip revision: Version label assigned to the tip revision.

 Any revision except for the tip revision: Version label not assigned to tip 
revision.

4 To inverse the logic of the filter, select the Show files not matched by this filter 
check box.

5 Click OK.

Filtering by Promotion Group
Use this filter to find files that include specified promotion groups.

To set a promotion group filter:

1 From the Filter list on the Status pane, select Advanced Filter. The Advanced Filter 
dialog box appears.

2 Select the Promotion Group option from the Filter by list.
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3 Enter the names of the promotion groups that you want to filter by in the Promotion 
group(s) field or browse to select them. Separate multiple promotion groups with the 
delimiter character. The default delimiter is a semicolon (;). For information on setting 
the delimiter character, see "Specifying a Delimiter for Items Entered in Fields" on 
page 53.

4 If the specified promotion group is not found, the filter can search for the next highest 
promotion group, continuing up the promotion model hierarchy until a match is found 
or the highest level of the promotion model is reached. To enable this feature, select 
the Climb the promotion model hierarchy check box.

5 Select one of the following options to show versioned files that contain the specified 
promotion groups in:

 Any revision: Promotion group.

 The tip revision: Promotion group assigned to the tip revision.

 Any revision except for the tip revision: Promotion group not assigned to tip 
revision.

6 To inverse the logic of the filter, select the Show files not matched by this filter 
check box.

7 Click OK.

Filtering by Comparing Two Version Labels
Use this filter to find versioned files with revisions that differ or match between two 
specified version labels.

To set a compare filter using two version labels:

1 From the Filter list on the Status pane, select Advanced Filter. The Advanced Filter 
dialog box appears.
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2 Select the Two Version Labels option from the Filter by list.

3 Enter the name of a version label that you want to filter by in the First version label 
field or browse to select one. 

4 Enter the name of a version label that you want to filter by in the Second version 
label field or browse to select one. 

5 Specify whether the files must contain:

 Both labels 

NOTE  Version labels are case sensitive. Make sure you use the correct case.



44 PVCS Version Manager 

Chapter 3  Navigating the Interface

 At least one of the labels 

6 Select one of the following options to specify how the revisions are compared:

 Revision number.

 Modification time.

 Modification time OR Revision contents: First compares the modification time 
of the revisions. If the modification time does not differ, then compares the 
revision contents. This option takes longer if many revisions have the same 
modification time.

 Revision contents: Compares the contents of the revisions. This option takes the 
most time.

7 Specify whether to show files where:

 The revisions are the same 

 The revisions are different 

8 To inverse the logic of the filter, select the Show files not matched by this filter 
check box.

9 Click OK.

Filtering by Comparing Two Promotion Groups
Use this filter to find versioned files with revisions that differ or match between two 
specified promotion groups.

To set a compare filter using two promotion groups:

1 From the Filter list on the Status pane, select Advanced Filter. The Advanced Filter 
dialog box appears.
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2 Select the Two Promotion Groups option from the Filter by list.

3 Enter the name of a promotion group that you want to filter by in the First 
promotion group field or browse to select one. 

4 Enter the name of a promotion group that you want to filter by in the Second 
promotion group field or browse to select one. 

5 Specify whether the files must contain:

 Both groups 

 At least one of the groups 

6 Select one of the following options to specify how the revisions are compared:

 Revision number.
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 Modification time.

 Modification time OR Revision contents: First compares the modification time 
of the revisions. If the modification time does not differ, then compares the 
revision contents. This option takes longer if many revisions have the same 
modification time.

 Revision contents: Compares the contents of the revisions. This option takes the 
most time.

7 Specify whether to show files where:

 The revisions are the same 

 The revisions are different 

8 To inverse the logic of the filter, select the Show files not matched by this filter 
check box.

9 Click OK.

Filtering by Comparing a Version
Label and a Promotion Group
Use this filter to find versioned files with revisions that differ or match between a specified 
version label and a specified promotion group.

To set a compare filter using a version label and a promotion group:

1 From the Filter list on the Status pane, select Advanced Filter. The Advanced Filter 
dialog box appears.
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2 Select the One Label and One Promotion Group option from the Filter by list.

3 Enter the name of the version label that you want to filter by in the Version label 
field or browse to select one. 

4 Enter the name of the promotion group that you want to filter by in the Promotion 
group field or browse to select one. 

NOTE  Version labels are case sensitive. Make sure you use the correct case.
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5 Specify whether the files must contain:

 Both the label and the group

 The label and/or the group

6 If the specified promotion group is not found, the filter can search for the next highest 
promotion group, continuing up the promotion model hierarchy until a match is found 
or the highest level of the promotion model is reached. To enable this feature, select 
the Climb the promotion model hierarchy check box.

7 Select one of the following options to specify how the revisions are compared:

 Revision number.

 Modification time.

 Modification time OR Revision contents: First compares the modification time 
of the revisions. If the modification time does not differ, then compares the 
revision contents. This option takes longer if many revisions have the same 
modification time.

 Revision contents: Compares the contents of the revisions. This option takes the 
most time.

8 Specify whether to show files where:

 The revisions are the same 

 The revisions are different 

9 To inverse the logic of the filter, select the Show files not matched by this filter 
check box.

10 Click OK.

Viewing All Versioned Files (No Filter)
To clear a filtered view and display all versioned files, select All Files from the Filter list 
on the Status pane.
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Summary of regular-expression constructs

Construct Matches

Characters
x
\\
\0n
\0nn
\0mnn

\xhh
\uhhhh
\x{h...h}

\t
\n
\r
\f
\a
\e
\cx

The character x
The backslash character
The character with octal value 0n (0 <= n <= 7)
The character with octal value 0nn (0 <= n <= 7)
The character with octal value 0mnn (0 <= m <= 3,
0 <= n <= 7)
The character with hexadecimal value 0xhh
The character with hexadecimal value 0xhhhh
The character with 
hexadecimal value 0xh...h (Character.MIN_CODE_POINT  <
= 0xh...h <=  Character.MAX_CODE_POINT)
The tab character ('\u0009')
The newline (line feed) character ('\u000A')
The carriage-return character ('\u000D')
The form-feed character ('\u000C')
The alert (bell) character ('\u0007')
The escape character ('\u001B')
The control character corresponding to x

Character classes
[abc]
[^abc]
[a-zA-Z]
[a-d[m-p]]
[a-z&&[def]]
[a-z&&[^bc]]
[a-z&&[^m-p]]

a, b, or c (simple class)
Any character except a, b, or c (negation)
a through z or A through Z, inclusive (range)
a through d, or m through p: [a-dm-p] (union)
d, e, or f (intersection)
a through z, except for b and c: [ad-z] (subtraction)
a through z, and not m through p: [a-lq-z](subtraction)

Predefined 
character classes
.
\d
\D
\s
\S
\w
\W

Any character (may or may not match line terminators)
A digit: [0-9]
A non-digit: [^0-9]
A whitespace character: [ \t\n\x0B\f\r]
A non-whitespace character: [^\s]
A word character: [a-zA-Z_0-9]
A non-word character: [^\w]

Boundary 
matchers
^
$
\b
\B
\A
\G
\Z
\z

The beginning of a line
The end of a line
A word boundary
A non-word boundary
The beginning of the input
The end of the previous match
The end of the input but for the final terminator, if any
The end of the input
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Greedy quantifiers
X?
X*
X+
X{n}
X{n,}
X{n,m}

X, once or not at all
X, zero or more times
X, one or more times
X, exactly n times
X, at least n times
X, at least n but not more than m times

Logical operators
XY
X|Y
(X)

X followed by Y
Either X or Y
X, as a capturing group

Construct Matches
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Setting Version Manager Web Client Options
You can specify how many items per page the web client displays, how it handles check 
in/check out/get, whether to include subprojects, and how results dialogs are handled. 
These options are saved per user ID, allowing them to be retained when you start another 
Version Manager web client session.

Default Version Manager Web Client Options
Unless you change the defaults, the Version Manager web client:

 Displays up to 50 items per page.

 Leaves read-only workfiles in the workfile location after a check in.

 Copies a read-only revision when you perform a get.

 Prompts you if a workfile already exists during check out.

 Does not include subprojects in project operations.

 Does not automatically dismiss the Results dialog box after a successful action.

 Uses semicolons (;) to separate multiple entries in dialog box fields.

 Gets or checks out revisions whether or not they are newer than the existing 
workfiles.

NOTE  The options you set in the Version Manager web client do not affect any Version 
Manager desktop client options you have set.
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You can change these defaults in the Options dialog box 
(Edit | Options | General tab).

Setting Number of Items per Page
You can set the maximum number of files that appear on a 
Version Manager web client page at a time. If the number of files exceeds this limit, 
multiple pages are used to display the files. From the content pane, you can click the page 
number or click Previous or Next to access these pages.

To set the number of items per page:

1 On the Edit menu tab, click the Options button. The Options dialog box appears with 
the General tab active.

2 Enter the maximum number of files to display in the Number of items per page 
field. The default is 50.

3 Click OK.

Specifying a Delimiter for Items Entered in Fields
By default, semicolons (;) are used to separate multiple entries in dialog box fields. The 
delimiter character is used in all fields that accept multiple entries. 
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You need to change the delimiter character if you work with items that use it in their 
names. You can set the delimiter to be a comma (,), colon (:), or semicolon (;).

To specify a delimiter character:

1 On the Edit menu tab, click the Options button. The Options dialog box appears with 
the General tab active.

2 From the Delimiter list, select one of the following:

 Comma 

 Colon 

 Semicolon (default)

3 Click OK.

Defining Check In/Check Out Options
If you find that you usually change the default options when you perform check in/check 
out/get operations, the Version Manager web client enables you to change these default 
settings to fit your working style.

To change check in/checkout/get options:

1 On the Edit menu tab, click the Options button. The Options dialog box appears with 
the General tab active.

2 Change the defaults as necessary:

 Get read-only revision: To make workfiles writable when you perform a get, 
clear the this check box.

 After checkin: To deternmine what to do with the workfile after checkin, select 
one of the following from the drop-down menu:

• Keep read only workfile (This is the default setting.)

• Delete writable workfile 

• Keep writable workfile 

 If Workfile Exists: To determine what to do when a workfile already exists, 
select an option from the drop-down menu:

• Prompt: Asks you what to do. (This is the default setting.)

• Overwrite: Adds the workfile even if a duplicate workfile exists.

• Don’t Overwrite: Does not add the workfile.

 Get only if revision is newer than workfile: To get or check out a revision only 
if it is newer than the workfile, select the this check box. This saves time by not 
getting revisions that have not changed.

3 Click OK.

IMPORTANT!  Choose a delimiter character that is not present in the items you wish 
to enter into dialog box fields.
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Defining Revision Lookup Behavior
Since Get operations ignore promotion groups unless you specify one in the Promotion 
Group field, a Get operation and a Checkout operation may not return the same revision. 
By defining the revision lookup behavior, you can cause a Checkout operation to behave 
like a Get. These settings are relevant only when a promotion model is in effect.

To configure the default revision lookup behavior for Get and Checkout 
operations:

1 On the Edit menu tab, click the Options button. The Options dialog box appears with 
the General tab active.

2 Select one of the following from the Lookup options for Get and Checkout Dialog 
list:

 Classic lookup: 
For Get operations, if the user does not specify a revision, version label, or 
promotion group to act on, the default revision, if one is defined in the 
configuration file, will be retrieved. Else the Tip revision on the Trunk will be 
retrieved.

For Checkout operations, the revision defined by the lowest-level promotion 
group will be acted on. If such a revision is not found, the operation will climb the 
promotion model.

 Lookup revision based on Revision: The revision specified by the user will be 
acted on. If the user selects [Default Revision] in the Revision field, the 
revision specified by the workspace settings or configuration file will be acted on; if 
no default value is found, the Tip of the Trunk will be acted on.

 Lookup revision based on Promotion group: 
For Get operations, the revision assigned to the promotion group in the 
Promotion Group field of the Get dialog will be retrieved. If such a revision is not 
found, the operation will climb the promotion model and act on the revision 
assigned to the lowest currently assigned group in the promotion model.

For Checkout operations, the revision assigned to the promotion group specified 
in the Lowest-level promotion group field will be acted on.

If the user selects [Default Promotion Group] in the Lowest-level promotion 
group field, the revision currently assigned to the promotion group specified by 
the workspace settings or configuration file will be acted on. If a default is not 
defined, the lowest-level group in the promotion model will be used. If there are 
multiple lowest-level groups, the user will be prompted to select one. If such a 
revision is not found, the operation will climb the promotion model and act on the 
revision assigned to the lowest currently assigned group in the promotion model.

3 Click OK.

Including Subprojects in Project Operations
When you perform actions on project databases and projects, 
the Version Manager web client only performs actions on the versioned items contained 
directly at the project database or project level. The Version Manager web client does not 
include versioned files in subprojects as part of its default operation.
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If you usually include subprojects when you perform actions on project databases and 
projects, you can change the default to include subprojects.

To include subprojects:

1 On the Edit menu tab, click the Options button. The Options dialog box appears with 
the General tab active.

2 Select the Include subproject in project operations box.

3 Click OK.

Dismissing Results Dialog Boxes after Successful 
Action
By default, the Results dialog box appears after an action is complete to show if the action 
was successful, or if any errors or warnings occurred. You must click the Close button to 
dismiss the Results dialog box. If you want the Results dialog box to automatically close 
after an action is successful, you can change the default behavior.

To automatically dismiss Results dialog box:

1 On the Edit menu tab, click the Options button. The Options dialog box appears with 
the General tab active.

2 Select the Automatically dismiss results dialogs when action is successful box.

3 Click OK. 

If errors occur, the Results dialog box will not automatically close.

Setting Your Default Editor
Setting your default editor specifies which editor Version Manager launches when you 
click a versioned file in the Contents pane or a revision in the Revisions pane.

Windows On Windows, Version Manager opens the file in either the editor defined by the Windows 
file type associations or a specific editor you have selected. By default, Version Manager 
uses the Windows file type associations. We recommend that you use the Windows file 
type associations.

UNIX On UNIX, you must define the location of an editor so that you can launch files for editing 
or viewing from within Version Manager. The Use default Windows associations option 
is not available to UNIX users.

To set your default editor:

1 On the Edit menu tab, click the Options button. The Options dialog box appears with 
the General tab active.

2 Select the Applications tab.

NOTE  If the wrong application is launched when you double-click a file, correct the 
Windows file type associations using Windows Explorer (Tools | Folder Options | File 
Types tab).
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3 (Windows only) If you want to use the Windows file type associations to launch an 
editor, select the Use default Windows associations check box.

4 In the Editor Location field, enter the location of the editor program executable, or 
click the Browse button to select it.

 (UNIX only) If you specify a non-GUI editor that launches its own window (such as 
vi), you will need to launch the editor in an xterm or other type of window. For 
example, in the Editor Location field, you would enter:

xterm editor path

where editor path is the location of your editor.

 (Windows only) If you specify an editor and select the Use default Windows 
associations check box, the editor you specified will be used only if Windows 
cannot find an association.

5 Click OK.

Specifying a Difference or Merge Tool 
By default, Version Manager uses the PVCS merge tool when differencing or merging. 
However, you can configure Version Manager to use third-party difference and merge 
tools. 

Administrators have the option to define the default tool for a user the 
vm\common\inet\props\UserID\useropt.ini file instead of selecting it through the 
Options | Advanced tab.

For the list of arguments, see "Argument" on page 59 in this user guide.

To specify a difference or merge tool:

1 On the Edit menu tab, click the Options button. The Options dialog box appears with 
the General tab active.

2 Select the Advanced tab.

CAUTION!  The Administrator must be adept at making changes to the useropt.ini file 
as any errors could severely affect the Version Manager I-Net client for the user whose 
useropt.ini file is being modified.

Tool Name Sample islv.ini Configuration Information

PVCS merge tool pvcs.diff.tool.cmd.win32=pvcsmerge.exe

WinMerge pvcs.diff.tool.cmd.win32=D:\VM\Setup 
Files\WinMerge-2.8.0-exe\winmerge.exe /dl 
__AncestorLabel__ /dr __Derivative1Label__ 
__AncestorFile__ __Derivative1File__

TkDiff pvcs.diff.tool.cmd.win32=c:/progra~1/tkdiff/
tkdiff.exe __AncestorFile__ 
__Derivative1File__ -L __AncestorLabel__ -L 
__Derivative1Label__
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3 In the Diff command field and in the Merge command field, enter the location of 
the third party executable, or click the Browse button to select it. 

The argument selection button () facilitates two types of selections:

 Predefined Diff / Merge tools

Above the separator bar are names of predefined Diff/Merge tools like WinMerge, 
TkDiff and Version Manager PVCS Diff Tool. Select these options to replace the value 
of the Diff/Merge command with a set of arguments that work with these tools. 

 Arguments

If you want to manually construct a Diff/Merge command, you can select values 
(arguments) from below the separator bar. This will provide access to values in the 
Diff/Merge dialog as selected at run time.

NOTE  Except for the PVCS Diff Tool, the arguments are provided as an example only 
and are not guaranteed to work on all versions of those tools.

NOTE  An administrator can add, modify or delete the predefined Diff/Merge tools by 
changing the diffmerge.properties files. This file is stored in the directory vm/
common/pvcsprop/pvcs/vm.



Setting Version Manager Web Client Options

Web Client User's Guide 59

The following table is a list of difference and merge arguments that can be applied. 
The result column lists sample result values for each parameter:

4 Select the Three-way merge supported checkbox if the selected third party tool 
supports three way merging.

5 Click Ok.

For more information on using the diff/merge tool, see "Comparing Files" on page 67 and 
"Merging Files" on page 73 in this manual.

Passing Options Based on Ignore White Space 
Version Manager has an Ignore white space checkbox on the Show Differences 
dialog. It is possible to create an optional argument for the Diff tool based on the state of 
this checkbox. 

This can be done using the parameter __IfIgnoreWhitespace__. 

The syntax for this parameter is:

__IfIgnoreWhitespace__DiffArgumentIfBoxIsSelected|DiffArgumentIfBoxIsNo
tSelected|

For example, if your Diff tool expects the argument -b to ignore white space, you would 
include:

__IfIgnoreWhitespace__-b||

Argument Usage Result

_AncestorFile_ Use this parameter to select the base file (the file 
from which the other files were derived).

C:\DOCUME~1\Clyde~
1\LOCALS~1\Temp\un
uz781.tmp 

_AncestorLabel_ Use this parameter to pass a label that describes the 
ancestor file. 

Base: /Project1/
islvtk.ini 1.1

_Derivative1_/
_Derivative2_

Use these parameters to access the files associated 
with the Branch1 / Branch2 selections.

NOTE  Derivative2 is applicable only for the Merge 
command field and is used if the tool supports 
three way merge functionality.

C:\DOCUME~1\Clyde~
1\LOCALS~1\Temp\v6
dvuw0.tmp

_Derivative1Label_/
_Derivative2Label_

Use these parameters to pass labels that describe 
the Branch 1 / Branch 2 files (to be used as 
captions).

NOTE  Derivative2 Label is applicable only for the 
Merge command field.

Branch 1:  /
Project1/
islvtk.ini 1.0

_IsMerge_ This parameter will be replaced by true if the 
command is executed as part of a Merge operation, 
and false if it is executed as part of a Diff operation.

 _TargetFile_ Use this parameter to pass the output file path 
specified by the user in the Show Merge dialog.

C:\DOCUME~1\Clyde~
1\LOCALS~1\Temp
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in your list of arguments. 

If your Diff tool enables white space handling using arguments like --ignore-white-
space=true and --ignore-white-space=false, you can use:

__IfIgnoreWhitespace__-ignore-white-space=true|-ignore-white-
space=false|

Setting Workspace Properties
A workspace is a collection of work settings defined for a project database. You can define 
multiple workspaces so you can easily switch work settings to match your environment. 
Each user has one active workspace at a time. The work settings include:

 The workfile locations defined for the project database and its contents.

 The default version used when you do not specify a revision number or version label.

 The base version and branch version used for automatic branching, if enabled.

 The default promotion group used if a promotion model is in effect.

Public or private
workspaces

Workspaces can be public or private. A public workspace is typically created by an 
administrator when a project database is created. Any changes made to a public 
workspace affect everyone using that workspace. A private workspace is typically created 
by a user to customize the work settings for the user's personal work environment. Any 
changes made to a private workspace affect only the user who created it.

Root workspaces The Root workspace is the default public workspace. It is automatically created every time 
your administrator creates a project database. You cannot delete or rename the Root 
workspace. You can only change the settings of the Root workspace if your administrator 
has assigned you those privileges.

If you do not create or set any other workspaces, the Root workspace is set as the default 
workspace.

Setting Your Workspace
When start using the Version Manager web client, specify which workspace you want to 
use. You can also specify whether to make the workspace the default when you start 
another web or desktop client session.

NOTE  In the above example when a user selects Ignore white space, the option -
b will get passed to the specified Diff command. When it is not selected, no argument 
is passed.
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To set your workspace:

1 On the File menu tab, click the Set Workspace button. The Set Workspace dialog 
box appears.

2 Select the workspace from the Workspaces list that you want to use with the project 
database.

3 To associate this workspace with the project database for subsequent Version 
Manager web or desktop client sessions, select the Make this your default 
workspace box. Otherwise, this workspace is only active during your current Version 
Manager web client session.

4 Click OK.

Setting Your Workfile Location
The workfile location is the location where you check in and check out workfiles. It is set 
when the project is first created, and is stored in the workspace assigned to the project 
database.

You can change the workfile location for any project or versioned file in the project 
database. Changing the workfile location while in a public workspace changes the workfile 
location for all users accessing the project using that public workspace. If the workspace 
is private, then changing the workfile location will not affect other users.

To set a workfile location:

1 Select the project database, project, or versioned file.

2 On the File menu tab, click the Set Workfile Location button or click the Workfile 
Location link in the content pane. 
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The Set Workfile Location dialog box appears.

3 Enter or browse to the new workfile location in the Workfile Location field.

4 Click OK.

Defining the Default Revision
By default, the latest revision (tip) of the versioned file is used during get, check out, and 
lock operations. However, you can define the default revision to be a specific version label 
instead. 

To define the default revision:

1 Set the workspace you want to edit.

2 On the File menu tab, click the Properties button. The Properties dialog box appears.

3 Enter a version label in the Default Version field and click OK.

Enabling Automatic Branching
Automatic branching lets you create a branch automatically from a trunk revision. Then, 
by default, you operate on the tip revision of that branch whenever you perform an 
action. 

To set up automatic branching, you assign two fixed version labels to the revision from 
which you want to branch. One version label marks where the branch starts, and the 
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other marks the tip of the branch. You then specify these version labels in the active 
workspace. 

To enable automatic branching:

1 Select the versioned file(s) for which you want to enable automatic branching.

2 On the Actions menu tab, click the Label button. The Version Label dialog box 
appears.

3 Assign a fixed version label to the revision:

a Click the Assign option. 

b Enter the name of the version label in the Assign Version Label field. For 
example, Rel1.0 Base.

c Enter the revision number in the To revision field.

d Click OK.

This version label becomes the Base Version.

4 Repeat steps 2 and 3 to assign another fixed version label to the revision. For 
example, Rel1.5 Branch.

This version label becomes the Branch Version.

5 Select the project or project database that contains the versioned file(s).

6 On the File menu tab, click the Properties button. The Properties dialog box appears.

7 On the Workspace Settings tab:

a Enter the version label for the branch version in the Default Version field. This is 
the label you assigned in Step 4 (for example, Rel1.5 Branch).

b Enter the version label for the branch version in the Branch Version field. This is 
the label you assigned in Step 4 (for example, Rel1.5 Branch).

NOTE  Before you set up automatic branching, check with your administrator to make 
sure you have the necessary security privileges. Also make sure that you coordinate 
version label names with the rest of your project team.



64 PVCS Version Manager 

Chapter 4  Customizing Your Environment

c Enter the version label for the base version in the Base Version field. This is the 
label you assigned in Step 3 (for example, Rel1.0 Base).

8 Click OK.

The Version Manager web client creates the branch when you check out the revision and 
then check it back in. The branch version label floats with the tip of the branch.

Defining the Default Promotion Group
You can only check out revisions to the lowest-level promotion groups reserved for 
development. Regardless of what promotion level a revision has reached, when you check 
out and lock a revision, you must assign the revision to the lowest-level promotion group 
to continue development.

If you have multiple promotion groups for development, the Version Manager web client 
prompts you to select which promotion group you want to assign to the revision you are 
checking out or locking. In the following example, you would choose between Dev and 
Bug_fix.

If you find that you are checking out revisions to the same lowest-level promotion group 
each time, you can specify which lowest-level promotion group to use by default. You 
specify the default lowest-level promotion group in the workspace.
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To define the default promotion group:

1 Set the workspace you want to edit. See "Setting Your Workspace" on page 60.

2 On the File menu tab, click the Properties button. The Properties dialog box appears.

3 Select the lowest-level promotion group from the Default Promotion Group list.

4 Click OK.
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About Comparing Files
Side-by-side
comparisons

Version Manager allows you to select two text files and compare them side-by-side to see 
the additions, deletions, and changes made to the files. You cannot compare binary files.

Compare revisions
and workfiles

The Show Differences option (Actions | Difference) allows you to compare:

 A revision and a workfile

 Revisions in a single versioned file

 Revisions in two different versioned files

 Two workfiles

View only The Show Differences option provides a quick comparison of two files. You cannot print or 
save the comparison.

Viewing Differences
To view the differences between files:

1 Select the versioned file(s) or revision(s) that you want to compare. You can select 
any text files.

NOTE  To compare revisions located in different projects (but within the same 
project database), select the project database. You cannot compare revisions located 
in different project databases.
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2 Select Action tab | Difference. The Show Differences dialog box appears.

3 Select the type of comparison that you want to perform in the Compare drop-down 
menu.

4 To change the revision (or file, if comparing workfiles) selected as the first file, edit 
the field or click the Browse button.

5 To change the revision (or file, if comparing workfiles) selected as the second file, edit 
the field or click the Browse button.

6 Select the Ignore white space check box if you want to ignore trailing, intervening, 
and leading white spaces, tabs, and form feeds.

NOTE  The appearance of the Show Differences dialog box varies depending on the 
type of comparison you select.

To compare… You must specify…

A revision and a workfile A versioned file and revision number, and a workfile

Revisions in a single 
versioned file

A versioned file and revision number, and a second 
revision number

Revisions in different 
versioned files

Two versioned files and two revision numbers

Workfiles Two workfiles
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7 Click OK. The Merge Tool is launched with the two files side-by-side in separate 
panes.

8 To view the differences, scroll through the files and compare the colored text blocks.

Windows users can also click the Next Difference button ( ) to jump directly to 
the next difference.

Interpreting Difference Results
Types of

differences
File 1 is used as the base file. File 2 is compared to File 1. Differences between the files 
are categorized into additions, deletions, and changes.

 Additions are the lines of text that were added to File 2. These lines of text are not in 
File 1.

 Deletions are the lines of text that were deleted from File 2. These lines of text are in 
File 1.

 Changes are the lines of text that were modified in one of the files.

Placeholders Placeholders are the blocks of colors used to identify the types of differences between the 
files. Each difference type (additions, deletions, and changes) has two placeholders (or 
colors) assigned to it: one for selected one for unselected.

Windows users Windows users have the option of changing the colors of the placeholders. To change the 
colors, from the Merge Tool, click the Configuration button ( ) and select the Colors 
tab.
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Windows users also have the option of displaying a color legend to help identify what each 
placeholder stands for. To display the color legend, from the Merge Tool, click the Color 
Tips button ( ). The Color Tips dialog appears.

Difference Examples
The following examples show how the differences between two files can vary depending 
on the file you select as File 1 (the base file).

Example 1 This example shows two revisions from the same versioned file. Version 1.0 was selected 
as File 1 (base file) and version 1.2 was selected as File 2.

Lines 4, 5, and 6 have been changed and are highlighted as one block of differences. 
These differences are identified by change placeholders. Line 6.5 was added to File 2 and 
is highlighted as another block of differences. These differences are identified by addition 
placeholders.

File 1 (version 1.0) File 2 (version 1.2)

Changes

Additions
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Example 2 Using the same files above but reversing the order of the files, you get the following 
results.

Lines 4, 5, and 6 are still highlighted as differences and identified by change placeholders. 
However, the added line, line 6.5, is now in File 1 (the base file) but no longer in File 2. 
This difference is identified by deletion placeholders.

File 1 (version 1.2) File 2 (version 1.0)

Changes
Deletions
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About Merging 
What is merging? Merging is the process of comparing the differences between two (or more) text files, or 

revisions of text files with a common base file, accepting or rejecting the differences 
between them, and combining the changes into a new text file.

You cannot compare or merge binary files.

Why merge files? Merging is useful for parallel development. It enables you to combine the work performed 
on a branch of development and integrate it back into the main line of development.

Types of merges Version Manager allows you to perform a variety of merges. You can merge:

 A revision with a workfile

 Revisions within a single versioned file

 Revisions in different versioned files

 Workfiles

Windows users Version Manager for Windows can perform N-way (unlimited) merges. Although you can 
select only three files (one base and two branch files) from within Version Manager, you 
can perform an N-way merge once the Merge Tool is launched. For information on how to 
perform N-way merges, please see the Merge Tool online help.

UNIX users Version Manager for UNIX can perform two-way (a base file and a branch file) merges. N-
way merges are not supported on UNIX.

Merging Terms and Definitions
The following table is a list of basic merge terms and definitions:

Term Definition

Base or Ancestor The base file from which other files are derived.

Branch or 
Derivative

The result obtained by making changes in the base file.

Output or Target The final merged file.

Addition A line of text added to a branch file. This line of text is not in the 
base file.

Deletion A line of text deleted from a branch file. This line of text is in the 
base file.

Change A line of text that was modified in one of the branch files. The 
content of this line of text differs between the branch file and the 
base file.

Conflict
(Windows only)

A line of text that was modified in multiple branch files. The 
content of this line of text differs between the branch files and the 
base file.

NOTE  In UNIX, changes are treated as conflicts and must be resolved by the user.
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The Merge Process
The merge process consists of:

 Locking the tip of the branch or trunk where you want to check in the output (target) 
file

 Selecting a base file (ancestor) as a reference point

 Selecting a revision branch file (derivative) 

 Entering an output (target) file name

 Resolving conflicts between the base and branch files by either accepting or rejecting 
the changes made 

 Saving the changes made to the output (target) file

 Checking in the output file

Selecting a Base File
A base file is the file that you want to use as your point of reference. It is usually the 
branch point—the revision from which a branch begins (typically off the main trunk of 
development).

If you are merging revisions that are located in different branches or versioned files, the 
base file you select should be the revision or file that is the latest file to be created which 
is a common ancestor to all of the revisions that you want to merge. 

The closer the content of the base file is to that of the files you are merging, the fewer 
conflicts you will have to resolve. For example, if you want to merge the changes from 
revision 1.2.1.2 with revision 1.4.1.1, you would use revision 1.2 as the base file. You 
could use revision 1.1 or 1.0 as the base file, but we recommend using the revision that is 
closest to the files you are merging. 

Merging Files in Windows or UNIX
To merge files:

1 Lock the tip of the branch or trunk where you want to add the results of the merge.

2 Select the versioned file(s) or revision(s) that you want to merge.

When selecting files to merge, consider the following:

 The order in which you select the files determines which file will be the base and 
which the branch file(s). The first file that you select is the base file; the second 
and (on Windows only) third files that you select are the branch files.

IMPORTANT!  UNIX Only:

If you are merging or comparing revisions on a branch to revisions on a trunk on UNIX, 
you should set the base file to the latest revision on the trunk, then select the latest 
revision on the branch as the branch file.
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 The items you select (project, versioned file, or revision) affect the initial options 
that appear.

 (UNIX only) To merge a trunk and branch revision, you must set the base file to 
the tip revision on the trunk, and the branch file to the tip revision on the branch.

 To merge revisions located in different projects (but within the same project 
database), select the project database. You cannot merge revisions located in 
different project databases.

 (Windows only) If you want to merge just two files, enter the same file in the Base 
and Branch 1 fields; use the Branch 2 field for the second file.

3 Select Actions | Merge. The Show Merge dialog box appears.

4 Select the type of merge that you want to perform from the Merge drop-down menu.

NOTE  You can change the options when the Show Merge dialog box appears.

NOTE  The appearance of the Show Merge dialog box varies depending on the type 
of merge you select.

To merge… On Windows you must specify… On UNIX you must specify…

A revision and a 
workfile

A base file and revision number, a branch 
revision number, and a branch workfile

A base file and revision number, and a 
branch workfile

Revisions in a single 
versioned file

A base file and revision number, and two 
branch revision numbers

A base file and revision number, and a 
branch revision number
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5 To change the revision (or file, if merging workfiles) selected in the Base group, click 
the Browse button. 

6 To change the revision (or file, if merging workfiles) selected in the Branch 1 
(Windows) or Branch (UNIX) group, click the Browse button.

7 (Windows only) To change the revision (or file, if merging workfiles) in the Branch 2 
group, click the Browse button.

8 Enter the name of the output (target) file in the Output File field, or click the Browse 
button to select an existing workfile.

Revisions in different 
versioned files

A base file and revision number, and two 
branch files with revision numbers

A base file and revision number, and a 
branch file and revision number

Workfiles A base workfile and two workfiles A base workfile and a branch workfile

To merge… On Windows you must specify… On UNIX you must specify…

NOTE  UNIX Only:

To merge a trunk and branch revision on UNIX, you must set the base file to the tip 
revision on the trunk.

NOTE  UNIX Only:

To merge a trunk and branch revision on UNIX, you must set the branch file to the tip 
revision on the branch.

NOTE  If you enter an output filename without entering a path, the output file will be 
created in the BIN directory within your Version Manager installation directory. If the 
filename already exists in the selected location, the old file will be overwritten.
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9 Click OK. On Windows, the base file and branch files appear in the Frames window 
and the results of the merge appear in the Output File window.

On UNIX, the base file and branch file appear in the Merge Tool window.

10 Resolve the conflicts between the base and branch files. For information on how to 
resolve the conflicts, see one of the following:

 "Resolving Conflicts Between Files in Windows" on page 82

 "Resolving Conflicts Between Files in UNIX" on page 83

11 To save the results of the merge to an output file, do one of the following:
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 On Windows, select File | Save Target.

 On UNIX, select File | Save As and click OK.

12 Open the output file and review it. If you are satisfied with the results of the merge, 
check the output file into the tip of the branch or trunk you selected in Step 1.

Interpreting Difference Results in Windows
Types of

differences
The file that you select as the base file is used as the basis of the output file. Branch 1 and 
branch 2 are compared against the base file. Differences between the base and branch 
files are categorized as additions, deletions, and changes.

 Additions are the lines of text that were added to a branch file. These lines of text 
are not in the base file.

 Deletions are the lines of text that were deleted from a branch file. These lines of 
text are in the base file.

 Changes are the lines of text that were modified in one of the branch files. The 
content of these lines of text differ between the branch file and the base file.

 Conflicts are the lines of text that were modified in multiple branch files. The content 
of these lines of text differ between the branch files and the base file.

Placeholders
Placeholders are the blocks of colors used to identify the types of differences between the 
files. Each difference type (additions, deletions, and changes) has two placeholders (or 
colors) assigned to it: one for selected and one for unselected.

NOTE  You do not need to re-enter the output path or filename.
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Displaying a color
legend

You can display a color legend to help identify what each placeholder stands for. To 
display the color legend, from the Merge Tool, click the Color Tips button ( ). The 
Color Tips dialog box appears.

Changing Placeholder Colors

To change the colors of the placeholders:

1 Click the Configuration button ( ).

2 Select the Colors tab.

3 Click on the background or text color that you want to change. 

4 Select a new color from the color palette and click OK.

Conflicts
Conflicts occur when the content of a line in multiple branch files differ from the content of 
the line in the base file.

Current color

Text Color

Background color

Current color

Background color

Text Color
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By default, conflicts appear as blocks of text that are shaded with slashes (/ / /). When 
you resolve a conflict, the slashes remain on the selected block of text while the 
unselected conflict blocks (which are now resolved) are shaded with Xs (XXX).

Changing Conflict Shading

To change the shading of the conflicts:

1 Click the Configuration button ( ).

2 Select the Colors tab.

3 Choose a shading pattern from the appropriate Conflicting lines drop-down menu. 

Interpreting Difference Results in UNIX
Types of

differences
The file that you select as the base file is used as the basis of the output file. The branch 
file is compared against the base file. Differences between the base and branch files are 
categorized as additions, deletions, and changes.

 Additions are the lines of text that were added to the branch file. These lines of text 
are not in the base file.

 Deletions are the lines of text that were deleted from the branch file. These lines of 
text are in the base file.

 Changes are the lines of text that were modified in the branch file. The content of 
these lines of text differ between the branch file and the base file.

Unresolved conflict

Unselected (/ / /) Unselected (/ / /)Unselected (/ / /)

Resolved conflict

Selected (/ / /) Unselected (XXX)Unselected (XXX)

Unselected Selected Resolved

NOTE  In UNIX, changes are treated as conflicts and must be resolved by the user.
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Placeholders
Placeholders are the blocks of colors used to identify the types of differences between the 
files. Each difference type (additions, deletions, and changes) has two placeholders (or 
colors) assigned to it: one for selected and one for unselected.

Displaying a color
legend

You can display a color legend to help identify what each placeholder stands for. To 
display the color legend, from the Merge Tool, select Help | Color Legend.

Changing Placeholder Colors

To change the colors of the placeholders, edit the Mgdiff Legend file with a text editor. 
This file is located in the /bin/app-defaults directory where you installed Version 
Manager.

Resolving Conflicts Between Files in Windows
By default, the Merge Tool automatically inserts all of the additions, deletions, and 
changes into the output (target) file, but not the conflicts. Before you can successfully 
merge revisions, you must resolve all conflicts.

On Windows, a conflict occurs when a line of text differs between multiple branch files and 
the base file. The Merge Tool cannot determine which block to select, so you must resolve 
the conflict by choosing which block of text you want in the output file.

To resolve conflicts between the base and branch files:

1 From the Frames window in the Merge Tool, click the Next Conflict button ( ) to 
jump to the next conflict block.

NOTE  To resolve conflicts, you must be able to identify the differences between the base 
and branch files. For information on how to identify the additions, deletions, and changes 
between base and branch files, see "Interpreting Difference Results in Windows" on page 
79.
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2 Resolve conflicts by right-clicking the block of text that you want to appear in the 
output (target) file. The conflict block that you select changes color and the shading of 
the unselected files changes to resolved.

3 Repeat steps 1-2 until all conflicts have been resolved.

4 Check the contents of the output (target) file. Make sure that you have merged the 
appropriate content into the output file.

5 Select File | Save Target to save the output (target) file.

Resolving Conflicts Between Files in UNIX
By default, the Merge Tool automatically inserts all of the additions and deletions into the 
output (target), but not the changes. Before you can successfully merge revisions, you 
must resolve all conflicts (changes).

On UNIX, a conflict occurs when a line of text has been modified in the branch file so that 
the content of this line of text differs between the branch file and the base file. The Merge 
Tool cannot determine which block to select, so you must resolve the conflict by choosing 
which block of text you want in the output file.

NOTE  On UNIX, changes are treated as conflicts and must be resolved by the user.

NOTE  To resolve conflicts, you must be able to identify the differences between the base 
and branch file. For information on how to identify the additions, deletions, and changes 
between base and branch files, see "Interpreting Difference Results in UNIX" on page 81.

To resolve conflicts between the base and branch file:

1 From the Merge Tool window, scroll to a conflict block.

2 Resolve the conflict by clicking the block of text that you want to appear in the output 
(target) file. The conflict block that you select changes color.

3 Repeat Steps 1-2 until all conflicts have been resolved.

Unresolved

Resolved

Right-click to select a conflict block
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4 Select File | Save As and click OK to save the output (target) file. You do not need to 
reenter the output path or filename.
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Appendix A: Naming Conventions and 
Restrictions

General Naming Conventions and Restrictions 86
Specific Naming Conventions and Restrictions 87
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General Naming Conventions and Restrictions
You can use most alpha, numeric, and special characters when creating or renaming 
Version Manager entities and paths. However, your operating system also determines the 
conventions that apply to file and directory names.

Prohibited Characters for Files and Directories
The following characters are prohibited by Version Manager, and most operating systems, 
when naming files or directories:

 Angle brackets (>) and (<)

 Asterisk (*)

 Colon (:)

 Pipe (|)

 Question mark (?)

 Quotation mark (")

 Slashes, forward (/) and backward (\)

 Space ( ) as the first or last character

 Tab

Naming Considerations for Cross-Platform 
Environments
When working in a cross-platform environment, be aware of any incompatibilities between 
the systems and limit your usage to that which they have in common. 

IMPORTANT!  On Windows systems, files and directories (and thus Version Manager 
entities and paths) cannot end with a period (.).

IMPORTANT!  In a cross-platform environment, you cannot place files into the same 
directory if they differ only be case. Such usage is possible only in UNIX-only 
environments.
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Specific Naming Conventions and Restrictions
The following table lists naming conventions and restrictions that apply to specific Version 
Manager entities and paths. 

Restrictions

Item Type Characters Length

Archives As listed in "Prohibited 
Characters for Files and 
Directories" on page 86, plus 
cannot use:

Ampersand: &
Brackets: [ ]
Parenthesis: ( )
Plus sign: +
Semicolon: ;

254 (full path including the 
file name)

NOTE Only the first 10 
characters of the archive 
suffix are significant in 
distinguishing identically 
named files in the same 
project.

Files and paths

(unless otherwise 
noted)

As listed in "Prohibited 
Characters for Files and 
Directories" on page 86.

254 (full path including the 
file name)

pvcs_bindir As listed in "Prohibited 
Characters for Files and 
Directories" on page 86.

254 (full path including the 
file name)

NOTE On UNIX, the name of 
the vconfig file and the 
separator character also 
count against the total 
length.

Project databases Cannot begin or end with a 
tab or space character. Any 
character can be used within 
the name.

Projects As listed in "Prohibited 
Characters for Files and 
Directories" on page 86, plus 
cannot be:

 The two-character 
name of: ..

 The one-character 
name of: .

 The one-character 
name of: @
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Promotion groups Ampersand: &
Brackets: [ ]
Comma: ,
Equal sign: =
Parenthesis: ( )
Plus sign: +
Question mark: ?
Semicolon: ;
Slash: /

User, group, and 
privilege names

Asterisk: *
Colon: :
Backward slash: \
Single quote: '
Quotation mark: "
Parenthesis: ( )

30

Version labels Ampersand: &
Asterisk: *
Brackets: [ ]
Colon: :
Equal sign: =
Minus sign: -
Parenthesis: ( )
Plus sign: +
Question mark: ?
Quotation mark: "
Semicolon: ;
Slash: /

NOTE The backslash (\) 
serves as an escape 
character. To create or delete 
a label that includes a 
backslash, the backslash 
must be preceded by 
another backslash (\\Label 
would result in \Label; 
\\\\Label would result in 
\\Label).

254

Restrictions

Item Type Characters Length
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